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Introduction 
The nesting is a function in TopSolid’Wood which allows you, from a Design document, to optimally nest all the 
Design file’s parts on defined panels. This makes it possible, for example, to optimize the number of panels in 
order to machine specific-shaped parts, or machine several parts in a single panel positioning on a CNC. 

General procedure 
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Preliminary settings 

Nesting parameter settings 

 From a Design document, open the nesting parameters using Tools > 
Options > Nesting > Nesting default parameters. 

 
Note: All the parameters shown here are default parameters. These then can be modified when creating the 
nesting. 

Complex nesting parameters 

Note: A complex nesting enables parts to be nested 
according to their shape, and not to their enclosing 
rectangle. 
The complex nesting mode is selected when creating the 
nesting.  
 
 
 
 
 
 
 
 
 
 
 

 Strategy for complex nesting: 

- Maximum filling: The nesting will place the part to cover the maximum area of the panel, with an 
automatic packing in the down left, down right, up left or up right corner of the panel. 

- Straight front tuning: The nesting will place the part to one side of the panel (Left, Right, Bottom or Top) 
to obtain a maximum loss part. 

 The Enable straight front automatically option is enabled with the Maximum filling mode. When the panel 
maximum filling exceeds the given loss rate (Maximum loss rate option), this option is used to nest the panel 
in Straight front tuning mode to obtain a loss part. 

 
 
Nesting in Maximum filling, Automatic packing mode. 
 
 
 
 
 
 
 
 
Nesting in Straight front tuning, Left packing mode. 
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Rectangular nesting parameters 

Note: A rectangular nesting allows parts to be nested 
according to their enclosing rectangle, and not to their 
shape. 
The rectangular nesting mode is selected when creating the 
nesting. 
 
 
 
 
 
 
 
 
 
 

 Strategy for rectangular nesting: 

- Standard: Parts are nested to obtain a minimum loss rate. 
- Big parts first: Big parts are nested first. The calculation time is better, but the loss rate may be higher. 

 Packing: Defines the corner where the nesting will start. 
 
 
Rectangular nesting with down right packing.  
 
 
 
 
 
 
 
Rectangular nesting with up left packing. 
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Result document parameters 

 
 

- Result files directory: Allows you to set a default folder where the nesting files will be automatically saved.  
This folder can be modified when creating a nesting. 
If no folder is specified, the nesting files will be saved in the project directory. 

- Template document: A 3D document can be selected here as a nesting template. It can be used, for 
example, to insert a default text in the nesting. 

 
 
Example of a default text added to the nesting using the 
template document. 

 
 
 
 
 
 
 

Gaps between parts 

The gap between parts is used to adjust the minimum distance between two 
nested parts. In general, this value is at least the diameter of the tool used to cut 
the parts.  
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Generate loss parts 

 

- Generate loss parts: This option generates in unused nesting areas some loss rectangular parts which will 
be calibrated during machining. 

- Loss part minimum length/width: Minimum dimensions of the free space available in the nesting panel to 
generate a loss part. 

 
Note: The generated loss part will be smaller than the provided minimum dimensions since there are two gaps 
between parts. 

 
The minimum loss part dimension is 100mm. 
A loss part is therefore generated in an area of 
120mm. 
However, the final loss part dimension is 92mm 
because the gap between parts is 14mm (120-
2x14=92mm). 

 
 
 
 
 
 
 

- Generate last loss part: This option can be unchecked if the last loss part of a panel should not be created. 
 

Last loss part created 
 
 
 
 
 
 
 
 
 
 
 

Last loss part not created   
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Margins 

- Margins: Allows you to apply margins to the four sides of the panel during the nesting. 
 

 
 
 
 
 
 
 
 
 

Label symbol 

 
 

- Generate label symbol: Places a label symbol on nesting parts to simplify the reading direction in label 
documents. 

- Position: Sets the position of the label symbol on the part. 
- Label symbol document: Defines a Design file as a label symbol. 

If no label symbol is defined here, the default label symbol will be used (shown in blue below). 
 

 
 
 
Example of a customized grain 
orientation label symbol. 
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Creating a label symbol template 

 Create a new Design document. 

 Draw the new label symbol using Curves and/or Texts. 
 
Note: The center of the label symbol is the absolute coordinate system, the top of the label symbol is the Y+ 
direction and the right of the label symbol is the X+ direction. 
 

 From the tree, insert the label symbol elements in the main assembly: 
right-click on ASSEMBLY > Insert > Select elements. 
 

 Save the Design file. 
 
Note: The default label symbol file is under: Missler\V613\bin\dnestinglabelsymbol.top. 
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Standard support adjustments 

Standard support adjustments allows you to create and modify in the database 
the panels used to nest the parts. 

Creating/Modifying panels 

 Select Add to create a new panel.  

 Select Copy to copy an existing panel.  

 Select Modify to modify a panel.  

 Select Delete to delete a panel.  
 
When adding or modifying a panel, the following window appears. 

- Panel reference 
- Panel designation 
- Panel material 
- Panel coating 
- Panel dimensions 
- OK 
- Cancel 

 
 
 

 
 
Note: If the panel has grain orientation, the grain orientation 
dimension must be the panel length. 
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Miscellaneous 

Panel search 

Allows you to find panels more easily in the database. 

 Search: Starts the search function based on the text entered in the search field. 

 Stop: Quit the search function. 
 
Note: The search is carried out on the Reference, Designation and Material columns. 
The search is case sensitive. 

Displaying the panel database 

 
 
Displaying the database allows you to view the panel database. 
 
Note: By default, the database is sorted alphabetically according to the Reference column. This sorting can be 
modified by clicking another column header. 
 

Generic support 

The standard support database should normally contain all the Panel Material/Thickness/Dimensions 
combinations used. 

As there may be many combinations, the process can be simplified by defining a generic support using a "virtual" 
material. 
Not considering the material will significantly reduce the number of supports.  

For example, a white melamine board will have the same thickness and dimensions as a blue or yellow melamine 
board most of the time. 
Then, when generating a nesting, you will just have to select the generic board with the right dimensions. 
 
Of course, for a full control of the nesting generated with all the stock with their reference supplier information, it 
is possible to create all the supports. 
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Exercise 1: Complex nesting using a file 
 
 
 
 
 
 
 
 
 
 

Creating the nesting 

 Open the Design file plane.top. 

 Select the Wood > Nesting > Automatic Nesting function.  

Note: The Design file that contains the parts to be nested must be saved before starting the nesting. 
Several options are available in the dialog bar: 

- Main assembly: Used to select all the parts in the main assembly of the current document. 
- Multi-files: Used to select parts in several Design files (see Exercise 2). 
- Depth: Sets the depth type to select the parts in assemblies. 
- Filter bom by criteria: Filters the parts in the assembly. 
- Update machining face: With this option, if part machining faces are defined in Update machining mode, 

these part faces will be updated. 
- Select elements to use: Allows you to manually select several parts of the current document. 

 

 Set:  

- Depth = Flat BOM 
- Filter bom by criteria = No filter 
- Update machining face = Yes 

 

 Next select Main assembly.  
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The window for selecting parts by criteria opens. 

 Select by material all Ash-european parts. 

 Set Number of specimen: 2. 

 Validate with OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The nesting definition window opens, allowing you to set the nesting general parameters. 
 

 In this window, set the following: 

- Nesting: Complex 
- Make one nesting with all selected 

parts 
- Select all possible nestings 
- Do not use coatings 
- One nesting file for all supports 
- Result file name : Plane nesting 

 
Note: In this case, all the parts must be 
nested on the same support and in the same 
Design file. 

 Validate with OK. 
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Note: 

- Make one nesting with all selected parts: Allows you to perform a nesting with all parts, without 
considering the material, the thickness and the coating of the selected parts. This will force the parts on 
another type of panel. 

- Make one nesting by group of parts: Allows you to perform a nesting for each possible nesting. 

- Possible nestings: All the different materials detected in the selected parts (material-coating-thickness). It 
is possible to select/unselect all possibilities in order not to nest them. 

- Use coatings: Allows you to use the part and panel coatings to help differentiate during nesting the parts 
and panels with the same material, but a different coating. 

- Nesting files: 

One nesting file by group of supports: Creates a nesting file for each type of panel used. The file names 
are then set in the Nesting tab. 

One nesting file for all supports: Nests all panels in the same nesting file. Each group is placed on a 
different level. The file name is set in the Result file name field. 

One nesting file by support: Each panel is placed in a new Design nesting file. The file name is then set in 
the Nesting tab and followed by #Panel_Number. 

 

 Select a folder in which to save the nesting definition file. 

 Change the default file name to Plane nesting definition. 
 

The nesting configuration window opens with 3 tabs: Parts, Supports and Nesting. 
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Nesting parameters 

Parts 

The Parts tab allows you to set the nesting parameters specific to each part. It is possible to set several parts 
using multiple selection (Ctrl + left click). 

- A list of parts with each part, its assembly, its reference and its quantity. 
- Add/Suppress: Allows you to add new parts or curves (in the current document or not) and delete parts to 

be nested. 
- Up and down arrows: Moves up/down the parts in the list (this changes nothing to the nesting). 
- Color: Allows you to assign colors to the nesting parts (by default, the part color used in the assembly). 
- Automatic color: Allows you to assign colors to parts automatically. All identical parts will have the same 

color. 
- A preview of the part with its box dimensions on X and Y. 
- Wanted quantity: Quantity of the part to be nested. 
- Priority: Used to nest the parts in order of priority. If the value is greater, the priority will be lower (parts 

that will be first nested have a priority 0). 
- Completion part: Used for parts to be produced in greater quantities than required. The desired quantity 

may not be reached. This part will be placed on panels so long as there is available space.  
- Place in loss: The nesting will place parts in the 

apertures of another parts. This option must be 
enabled on the part which has the aperture. 

 
 
 
 
 
 
 
 

- Liberties: Adjusts the part rotation. 

Step: Part rotation step (a 90° step will give 4 rotation possibilities on 360°). 

If the step is high, the calculation time will be faster, but the nesting can be performed with a higher loss 
rate.  

Note: A part with grain orientation will have a step of 180°. 

Maximum/minimum: Two angle values between which the part can turn. 
The last field summarizes the different nesting possibilities: First angle° - Second angle° … - Last angle°. 

- Symmetries around vertical axis: Allows the part to be placed symmetrically on the support. 

Note: Do not use this option if the two part’s faces are not exactly the same. 

- Warning: Warnings are displayed before the material, coating and thickness boxes if one of the nested 
parts is not exactly the same as one of the selected supports. These warnings are indicative and will not 
stop the nesting creation. 
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 Select all the parts in the list and apply the following parameters: 

- Color > Automatic. 
- Step: 20°/Minimum 0°/Maximum 360°. 
- Allow symmetries around vertical axis. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
  



TopSolid’Wood: Nesting training  Exercise 1: Complex nesting using a file 

Missler Software  15 

Supports 

The Supports tab allows you to select the panels to nest the parts. 
If matching supports are found in the support database (material, thickness and coating if the Use coatings option 
is checked), they are automatically added to the list. 

- Add standard: Used to add an existing standard support and manage them (modification, creation…). 
- Add: Creates a new support for this nesting only (it will not be saved). 
- Suppress: Removes a support from the list. 
- Quantity or Free quantity: Allows you to provide a specific quantity or not for the selected support. 
- Priority: The greater the value, the less the priority. The support with a priority 0 will be used first. 
- Margins: Margins applied to the support’s sides (default parameter values). These margins are the same 

for all supports in the list. 
 

 Select Add.  

 Set: 

- Reference: PA-ASH-6 
- Designation: Ash panel 6mm 
- Material: Woods > Ash-european 
- Length: 1000mm 
- Width: 500mm 
- Thickness: 6mm 

 Validate the panel with OK. 

 Select the Free quantity option. 

 Apply 20mm margins to each panel’s side. 
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Nesting 

The Nesting tab allows you to set the nesting parameters. By default, the settings are those configured in Tools > 
Options. 

  Set: 

- Maximum filling – Automatic packing. 
- Gaps between parts: 10mm. 
- Uncheck Generate nesting with curves. 
- Uncheck Generate loss parts. 

 
Note: The Generate nesting with curves option performs the nesting with the outside contour of the part only. 
Without this option, the 3D parts are nested. 

 

 Validate with OK to generate the nesting. 

  



TopSolid’Wood: Nesting training  Exercise 1: Complex nesting using a file 

Missler Software  17 

A nesting generates two types of files: 

 One nesting definition file: This file contains a simple text which summarizes all the nesting parameters: 

- The number of generated result files. 
- The support’s material and thickness. 
- The gap between parts. 
- The list of nested parts. 
- The support’s reference and designation. 
- The support’s margins. 

 
This file allows you to modify the nesting (parameters and nested parts) and recalculate the result. 

 One or more nesting result files: These files contain the results of the parts nested on the support. Here it is 
possible to move the parts on the support (only for a complex nesting). These files are used to generate the 
draft files (supports and labels) and machine the panels. 

 
 

Nesting definition file Nesting result file 
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Modifying the nesting 

You can modify all the parameters of a generated nesting. 

 Close the nesting result file. 

Note: To recalculate the nesting, the result files must be closed. 

 Open the nesting definition file to be modified. 

 From the tree, right-click > Edit set > Nesting set. 

 
 
The different possible nestings that were performed are shown here. 

 On the nesting to be modified, right-click > Modify.  
 
The nesting parameter window opens. It is the same as when the nesting is 
created, with an additional Result file tab: it displays the nesting result files with 
their creation date. 
 
 
 
 

 Open the Nesting tab. 

 Change the strategy to Straight front tuning > Left packing. 

 Validate the window with OK.  
 
Note: The nesting modification will generate new nesting 
result files and replace the old generated files.  
A window appears to confirm the deletion of these files. 

 Validate the file deletion with OK. 
 
 
The new nesting result file is generated. 
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With a complex nesting, it is also possible to manually move the parts in a nesting. 

Note: You cannot move the parts in a rectangular nesting. 

 From the nesting result file, select Move parents.  

 Select the part to move in the nesting support. 
 
Note: The part can only be moved on the same support. 
 

 

Several options are available to move the part: 

- Rotate: This option allows the part to rotate with a default step using the 90.0 button. Select this button 
to modify the rotation step. 

The Rotation = field displays the part’s global rotation angle.  
 
- Free moving: This option set to Yes is used to move the part freely on the support, without considering the 

other parts, the support’s margins and the gap between parts. 
If the part is placed on another part, in the support’s margins or in a gap with another part, the moved 

part is shown in orange and it will not be possible to validate the new part’s positioning.  
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- Free positioning: When this option is set to Yes, it is possible to validate a bad positioning of the part 

(when the part is orange with the Free moving = Yes option).  

Note: Be careful with this option because the machining can be wrong with a bad positioning of the part. 

- Positioning: Sets the part’s positioning on the support. 
Free: The part can be positioned freely on the support. 
From top: The part’s top will be positioned only on the support’s top. 
From bottom: The part’s bottom will be positioned only on the support’s bottom. 
From center: The part’s center will be positioned only on the support’s center. 
 

Note: If the part is rotated, the side can change. 
 

From top From bottom From center 

   
 

- Y symmetry: This option allows you to make a symmetry of the part on Y to position it. 

 

 Move the part and left-click to position it. 

 Save and close the files. 
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Different nesting parameters and results 

Rectangular nesting 
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Complex nesting 
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Exercise 2: Creating a project  TopSolid’Wood: Nesting training 

24  Missler Software 

Exercise 2: Creating a project 

In this exercise, two projects will be nested together. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Configuring TopSolid’Wood 

Nesting parameters 

 Open the nesting parameters from a Design document using Tools > 
Options > Nesting > Nesting default parameters. 

 For the strategy for complex nesting, set the following. 

- Uncheck Enable straight front automatically. 

- Set Straight front tuning > Packing: Left. 

 Enter Gaps between parts: 20mm. 

 Check Generate loss part: 

- Loss part minimum length: 100mm 

- Loss part minimum width: 500mm 
- Check Generate last loss part. 

 Set all margins to 30mm. 
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Standard supports 

 Open the Standard supports configuration. 

 Select Add to create a new support.  

 Create the following support: 

- Reference: PB-22-STD 
- Designation: Particle board 22mm standard 
- Material: Wood > Particle board 
- Length: 2500mm 
- Width: 1200mm 
- Thickness: 22mm 

 Validate the support with OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Next create the two following supports: 
 

Reference PB-8-STD LAM-30 

Designation Particle board 8mm standard Laminate 30mm 

Material Wood > Particle board Wood > Laminate 

Length 2100mm 2500mm 

Width 1100mm 1200mm 

Thickness 8mm 30mm 

 
Note: To create the second particle board support, you can select the first created support, copy it and modify the 

copied support.  
 

 

 Validate the options with OK. 
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Creating the nesting 

 Create a new Design document. 

Note: When a nesting is performed on several Design files, it is not necessary to open these files. 

 Start the Wood > Nesting > Automatic nesting function.  

 Set: 

- Depth: Flat BOM 
- Filter BOM by criteria = No filter 
- Update machining face = Yes 

 

 

 Select the Multi-files option.  

 Double-click on the text Double-click to add a file. 

 Select the first bedroom file Bedroom 1.top. 

 Then add the second bedroom file Bedroom 2.top. 

 For these two assemblies, select the main set ASSEMBLY and set a number of 1 copy to produce for each 
assembly. 

 

 
 

 Validate the file selection with OK. 

A complete bill of material of the two main assemblies in the selected files is calculated. 

 Make a selection by criterions > Type > Nesting. 

 Validate the part selection window with OK. 
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The nesting parameter window opens. 

 Select as nesting Type: Complex. 

 Select as Nesting: Make one nesting by group of parts. 

Note: For all the selected parts, three nestings are possible (grouped by Material – Coating – Thickness): 

- Laminate – 30mm 
- Particle board – 22mm 
- Particle board – 8mm 

 
The Make one nesting by group of parts option will allow you to generate one nesting file for each possible 
nesting. 

 Select all the possible nestings (they are normally selected by default).  

 Uncheck Use coatings. 

 Select the One nesting file by group of supports option. 
 
Note: The One nesting file by group of supports option allows you to generate one nesting file for each possible 
nesting. It is the most suitable option to manage the nestings with different material groups. 
 

 

 Validate with OK and save the nesting definition file. 
 
The first nesting configuration opens, allowing you to set the parameters for the particle boards – 8mm. 

 
 

In the Supports tab, the support that was created in the options is 
automatically selected with its material and thickness. 
 
 
In the Nesting tab, all the default parameters are set, but they can be 
modified. 
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Note: The default TopSolid’Wood materials do not have the grain orientation information. The default rotation 
step is therefore 180°. 

 Select all parts in the list and change the step to 90°. 

 Validate with OK to generate the nesting. 
 

 
 
The following window allows you to configure the nesting for the particle boards – 22mm. 

 Select all parts in the list and change the step to 90°. 

 Validate with OK to generate the nesting. 
 

 
 
The last window allows you to configure the nesting for the laminates – 30mm. 

 Select all parts in the list and change the step to 90°. 

 Validate with OK to generate the nesting. 
  

 
 
Note: The nesting result files are named as follows: Material_thickness.  
These files are saved in the same folder as the nesting definition file. 
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Creating the draft document 

Support drafts 

 Start the Multi-draft nesting function.  

 Select Paper format = A4H.  

 Select the Explore option to draft several nesting files.  

 Select the folder where the nesting files were saved and validate with OK. 
 
A window opens, allowing you to select the draft template 
and the nestings to draft. 

 Select User templates > Standard template > A4H multi-
draft nesting TS Wood. 

The Nestings list displays the selected nesting files > 
Different nesting type contained > Support number. 

 Select the three nesting files. 

 Check the Save files and Close files options. 
 
 
 
 
 
 
 
 
The window for selecting a folder where to save the draft files opens. 

 Create a new subfolder Nesting support drafts and select it before validating with OK. 
 
Note: A draft file is created for each nesting file. These file are named as follows: Material_thickness and placed 
in a subfolder with the same name. 
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Label drafts 

 Start the Multi-draft nesting labels function.  

 Select Paper format = A4V.  

 Select Explore to draft several nesting files.  

 Select the folder were the nesting files were saved and validate with OK. 
 
The window allows you to select the draft template and the 
nestings to draft. 

 Select User templates > Standard template > A5H multi-
draft nesting labels TS Wood. 

 Select the three nesting files. 

 Check the Save files and Close files options. 
 
 
 
 
 
 
 
 
 
 
 
The window for selecting a folder where to save the draft files opens. 

 Create a new subfolder Nesting label drafts and select it before validating with OK. 
 
Note: A draft file is created for each nested panel. These files are named as follows: 
Material_Thickness_SupportNumber and placed in a subfolder named as follows: 
Material_Thickness. 
 
 
 
In each label draft file, each part nested in the support has its folio with a simple view, and a view of the part 
nested in the support. 
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